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Using This Guide

Congratulations on your purchase of an Avid Unity™ MediaNetwork 
workgroup. The MediaNetwork workgroup is a high-performance, high-
capacity, shared media storage platform for a workgroup of connected 
MediaNetwork clients. 

n The documentation describes the features and hardware of all models. 
Therefore, your system might not contain certain features and hardware that 
are covered in the documentation.



 Using This Guide
Who Should Use This Guide

This guide is intended for administrators who manage MediaNetwork 
workgroups.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, 
reminders, recommendations, and strong suggestions.

c A caution means that a specific action you take could 
cause harm to your computer or cause you to lose data.

w A warning describes an action that could cause you 
physical harm. Follow the guidelines in this document 
or on the unit itself when handling electrical equipment.

> This symbol indicates menu commands (and 
subcommands) in the order you select them. For 
example, File > Import means to open the File menu 
and then select the Import command.

t This symbol indicates a single-step procedure. Multiple 
arrows in a list indicate that you perform one of the 
actions listed.

k This symbol represents the Apple or Command key. 
Press and hold the Command key and another key to 
perform a keyboard shortcut.

Margin tips In the margin, you will find tips that help you perform 
tasks more easily and efficiently.

Italic font Italic font is used to emphasize certain words and to 
indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Click Quickly press and release the left mouse button 
(Windows) or the mouse button (Macintosh).
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If You Need Help
If You Need Help

If you have trouble using your MediaNetwork workgroup:

1. Retry the action, carefully following the instructions given for that task in 
this guide. It is especially important to check each step of your workflow.

2. Check for the latest information that might have become available after 
the documentation was published in one of two locations:

- If release notes are available, they ship with your application.

- If ReadMe files are available, they are supplied in your Avid 
application folder. ReadMe files are also available from Help.

n Release notes and ReadMe files are also available on the Avid Knowledge 
Center.

3. Check the documentation that came with your Avid application or your 
hardware for maintenance or hardware-related issues.

4. Visit the online Knowledge Center at www.avid.com/support. Online 
services are available 24 hours per day, 7 days per week. Search this 
online Knowledge Center to find answers, to view error messages, to 
access troubleshooting tips, to download updates, and to read/join online 
message-board discussions.

5. For Technical Support, please call 800-800-AVID (800-800-2843).

For Broadcast On-Air Sites and Call Letter Stations, call
800-NEWSDNG (800-639-7364).

Double-click Click the left mouse button (Windows) or the mouse 
button (Macintosh) twice rapidly.

Right-click Quickly press and release the right mouse button 
(Windows only).

Drag Press and hold the left mouse button (Windows) or the 
mouse button (Macintosh) while you move the mouse.

Ctrl+key
k+key

Press and hold the first key while you press the second 
key.

Symbol or Convention Meaning or Action
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 Using This Guide
Related Information

MediaNetwork workgroup administrators should refer to the following 
documents for more information:

• Avid Unity MediaNetwork Site Preparation Guide 

• Avid Unity MediaNetwork File Manager Setup Guide 

• Avid Unity MediaNetwork File Manager Failover Installation Notes 

• Avid Unity MediaNetwork Upgrade Notes 

• Avid Unity MediaNetwork PortServer Setup Guide 

• Avid Unity MediaNetwork Supported Configurations 

• Avid Unity MediaNetwork Management Guide 

• Avid Unity MediaNetwork Troubleshooting Guide 

• Avid Unity MediaNetwork Macintosh Fibre Channel Client Setup Guide 

• MediaNetwork Macintosh Fibre Channel Client Quick Start Card 

• Avid Unity MediaNetwork Windows Fibre Channel Client Setup Guide 

• MediaNetwork Windows Fibre Channel Client Quick Start Card 

• MediaNetwork Macintosh Ethernet Client Quick Start Card 

• Avid Unity MediaNetwork Windows Ethernet Client Setup Guide 

• MediaNetwork Windows Ethernet Client Quick Start Card 

• Avid Unity MediaNetwork Release Notes 

• Avid Unity MediaNetwork LANserver EX Setup Guide 

• Avid Unity MediaNetwork LANserver Upgrade Notes 

• Avid Unity MediaNetwork LANserver Release Notes 

Your MediaNetwork workgroup also have online Help that provides complete 
information about using the Setup Manager, the Administration Tool, and the 
Monitor Tool.
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How to Order Documentation
How to Order Documentation

To order additional copies of this documentation from within the 
United States, call Avid Sales at 800-949-AVID (800-949-2843). If you are 
placing an order from outside the United States, contact your local 
Avid representative.

Avid Educational Services

For information on courses/schedules, training centers, certifications, 
courseware, and books, please visit www.avid.com/training or call Avid Sales 
at 800-949-AVID (800-949-2843).
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Chapter 1
MediaNetwork Hardware 
Overview

A MediaNetwork workgroup provides shared access to audio and video files. 
This chapter provides an overview of the MediaNetwork and hardware, 
including:

• MediaNetwork Hardware Components

• File Manager and Backup File Manager

• Fibre Channel Adapter Boards

• MEDIASwitch 16-4G

• MEDIArray ZX4 Drive Enclosures

• Keyboard/Monitor/Mouse Assembly (Optional)

• Keyboard/Video/Mouse Switch (Optional)

• Uninterruptible Power Supplies (Optional)

• PortServer and PortServer Pro Systems

• MediaNetwork Editing Clients

For more information on the MediaNetwork workgroup, see Chapter 2. 



 Chapter 1 MediaNetwork Hardware Overview
MediaNetwork Hardware Components

A MediaNetwork workgroup contains interconnected components, 
customized to meet the needs of video editing. A typical environment might 
contain:

• One or more standard 19-inch NEMA or EIA storage racks (customer 
supplied)

• One Windows 2000® system that functions as the File Manager, with a 
Fibre Channel adapter board

• A second Windows 2000 system that functions as a backup File Manager, 
with Fibre Channel adapter board (optional)

• One or two MEDIASwitch 16-4Gs to connect the File Manager, the 
storage subsystem, and the Fibre Channel clients

• One or more PortServers or PortServer Pro systems that share workspaces 
across an Ethernet network

• Up to six MEDIArray™ ZX(3) drive enclosures that contain the drives

• Services software

• One keyboard/monitor/mouse (KMM) assembly that controls the File 
Manager, the backup File Manager, any attached PortServer or PortServer 
Pro systems (optional) 

• One keyboard/video/mouse (KVM) switch to connect the File Manager, 
the backup File Manager, the PortServer or PortServer Pro systems to the 
KMM (optional)

• Several uninterruptible power supplies (UPSs) to manage power to the 
File Manager, the storage, the PortServer or PortServer Pro systems 
(optional)

• One client kit for each Fibre Channel client that contains a Fibre Channel 
adapter board, the client software, and the user documentation

• One client kit for each Ethernet client that contains the client software and 
the user documentation
16



File Manager and Backup File Manager
File Manager and Backup File Manager

The File Manager is a rack-mount, dual-processor computer running the 
Windows 2000 Workstation operating system. 

The File Manager maintains the storage location information for the drive set 
by caching a complete set of file system metadata in memory. To ensure the 
integrity of this metadata, the File Manager uses error-correcting code (ECC) 
memory and periodically writes three complete copies of the metadata to 
multiple drives in the storage subsystem. The metadata is also written to the 
drive set when the File Manager service is shut down.

In addition to the active File Manager, another computer can be set up as a 
backup File Manager to provide system redundancy. The backup File 
Manager automatically picks up for the active File Manager, within 
1 to 2 minutes, if it goes offline for any reason.

Fibre Channel Adapter Boards

Each File Manager, PortServer and MediaNetwork Fibre Channel client 
requires a Fibre Channel adapter board to connect to the Fibre Channel 
network. 

The File Manager’s Fibre Channel adapter board allows it to connect to the 
storage subsystem, access the Fibre Channel drives, and manage and maintain 
the file system on the drives through the MEDIASwitch 16-4G. 

The client’s adapter board allows them to access the storage subsystem and to 
send messages to the File Manager through the MEDIASwitch 16-4G.

MEDIASwitch 16-4G

The shipping 4-Gb MEDIASwitch 16-4G contains 16 ports. The 
MediaNetwork workgroup can have 1 or 2 switches. The switch allows you to 
connect the File Manager, several PortServer or PortServer Pro systems, 
several MediaNetwork Fibre Channel clients, and up to six MEDIArray ZX 
drive enclosures (either individually or in pairs of daisy-chained enclosures) 
together.
17



 Chapter 1 MediaNetwork Hardware Overview
Each MEDIASwitch 16-4G isolates its ports, treating each port as an 
individual Fibre Channel Arbitrated Loop (FC-AL). This isolation localizes 
loop initialization events (adding or removing clients, or client restarts) to a 
particular port. This isolation also increases the stability of the Fibre Channel 
environment. 

All the connections and indicators are on the back of the MEDIASwitch 16-
4G. “A 16-Port MEDIASwitch 16-4G” shows the back panel connectors, port 
configurations, and status indicators for the 16-port MediaSwitches.

A 16-Port MEDIASwitch 16-4G

Each MEDIASwitch 16-4G port uses a small form-factor pluggable (SFP) 
connector to attach an optical cable to the MEDIASwitch 16-4G (see “Small 
Form-factor Pluggable Connector”). The connectors are removable so that you 
can reconfigure your MEDIASwitch 16-4G optical cable connections. 

MediaNetwork client ports

File Manager port

MediaNetwork client ports

Storage ports

Port 15Port 0
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MEDIArray ZX4 Drive Enclosures
Small Form-factor Pluggable Connector

MEDIArray ZX4 Drive Enclosures

The MEDIArray ZX4 drive enclosures, see “Rack-Mount MEDIArray ZX 
Drive Enclosure”, hold the drives in the MediaNetwork drive set. Each storage 
subsystem has at least one MEDIArray ZX4 drive enclosure. You can connect 
up to six MEDIArray ZX4 drive enclosures to the MEDIASwitch 16-4G to 
expand the capacity of the storage subsystem. Each enclosure contains 16 
drives.

n See the Avid MEDIArray ZX4 Setup Guide for more MEDIArray ZX 
information.

MEDIASwitch 16-4G

SFP connector

MZX-4
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 Chapter 1 MediaNetwork Hardware Overview
Rack-Mount MEDIArray ZX Drive Enclosure

Keyboard/Monitor/Mouse Assembly (Optional)

The KMM assembly provides a convenient 1U keyboard, monitor, and mouse 
that can be rack-mounted to control whichever computer the 
keyboard/video/mouse switch selects. This assembly eliminates the need for 
multiple keyboards, monitors, and mouse assemblies, and allows you to save 
on rack space. For more information, see “Keyboard/Video/Mouse Switch 
(Optional)” on page 20.

Keyboard/Video/Mouse Switch (Optional)

The KVM switch allows you to control the File Manager and any other 
computers rack-mounted with the File Manager using one keyboard, monitor, 
and mouse. You can switch from computer to computer by using the touchpad 
on the front of the KVM switch or from a keyboard.

Uninterruptible Power Supplies (Optional)

The UPSs provide power protection when there is a brownout, a power dip or 
spike, or a power outage. They can be configured to shut down the File 
Manager software and the MediaNetwork storage after approximately 
1 minute of power interruption.

n Avid recommends that you also use UPSs to protect the clients from potential 
data loss if a brownout or a power outage occurs. You must purchase these 
UPSs separately.

PortServer and PortServer Pro Systems

Both PortServer and PortServer Pro workgroups expand the client capacity of 
your MediaNetwork workgroup by allowing Avid workstations to access 
MediaNetwork workspaces without a Fibre Channel connection. These clients 
connect to your MediaNetwork workgroup using an Ethernet connection.
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PortServer and PortServer Pro Systems
PortServer Systems

The PortServer system connects to the Fibre Channel network. It can mount 
and share up to 21 workspaces; this number is limited by the number of 
available drive letters under the Windows 2000 operating system. The 
workspaces are mounted in alphabetical order. If you have more than 21 
workspaces, you can rename them to control which workspaces are mounted. 
For more information, see the Avid Unity MediaNetwork PortServer Setup 
Guide.

The PortServer system and its clients are connected to each other by an 
Ethernet network using a switch or a hub. PortServer clients include Windows, 
Macintosh®, and SGI® nonediting workstations.

PortServer systems support only file copying and file exchange. They are not 
intended to be used for editing purposes. If you need to do low-resolution 
editing, set up a PortServer Pro system instead. For more information, see 
“PortServer Pro Systems” on page 22.

“PortServer Workgroup” shows a typical PortServer system connected to a 
MediaNetwork workgroup.

PortServer Workgroup

You can add up to five PortServer systems to your MediaNetwork workgroup, 
each accommodating multiple PortServer clients. Adding a PortServer system 
does affect your MediaNetwork workgroup’s ability to support existing 
MediaNetwork clients by using a MEDIASwitch 16-4G port and a 
MediaNetwork Fibre Channel license.
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 Chapter 1 MediaNetwork Hardware Overview
PortServer Pro Systems

A PortServer Pro system provides all the same features as a PortServer 
workgroup, with the added benefit of being able to play, record or digitize, and 
edit DV-50 and other low-resolution media on Windows 2000 or Macintosh 
workstations. 

A PortServer Pro workgroup includes a dedicated Ethernet switch that 
facilitates the real-time media transfer between the PortServer Pro system and 
its clients. The Ethernet switch connects to the PortServer Pro system using 
Gigabit Ethernet and to the PortServer Pro clients using 100BASE-T Ethernet 
or Gigabit Ethernet.

“PortServer Pro Workgroup” shows a typical PortServer Pro workgroup 
connected to a MediaNetwork workgroup.

PortServer Pro Workgroup

You can add up to five PortServer Pro systems to your MediaNetwork 
workgroup, each accommodating multiple PortServer clients. Adding a 
PortServer system does not affect your MediaNetwork workgroup’s ability to 
support existing MediaNetwork clients except that it uses a MEDIASwitch 16-
4G port.

MediaNetwork Editing Clients

n This section pertains to MediaNetwork workgroups only.
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MediaNetwork Editing Clients
A MediaNetwork workgroup can support up to 24 Fibre Channel editing 
clients. Clients can be Macintosh, Windows NT, Windows 2000, or Windows 
XP systems. MediaNetwork clients run a variety of Avid applications, 
collectively known as the Avid Composer Products software.

n For an complete updated list of all supported systems and clients see the Avid 
Unity Release Notes that ship with your system.

Windows Clients

Windows and Macintosh clients can vary by release of the product For 
complete details on the Windows and Macintosh configuration requirements 
for each version of Avid Composer Products software, see the Avid Unity 
MediaNetwork Release Notes that came with your MediaNetwork workgroup.

PortServer and PortServer Pro System

A PortServer can have any workstation on your in-house network connect to it 
for file copying and file transfer. You can connect up to four PortServer 
systems to your MediaNetwork workgroup and mount different workspaces 
on each PortServer.

A PortServer Pro can support up to 20 Ethernet editing clients. You can 
connect up to 4 PortServer Pro systems to your MediaNetwork workgroup, 
and the they can support a maximum of 60 editing clients.

Other MediaNetwork Clients

MediaNetwork workgroups also allow you to attach other clients that provide 
additional services and functions for the workgroup. Avid Unity 
MediaManager allows you to search, catalog, and manage the assets currently 
stored on a MediaNetwork workgroup. Avid Unity TransferManager allows 
you to package the elements of an Avid sequence and send them to another 
client system, another MediaNetwork workgroup, or a playback device. Avid 
ProEncode allows you to off-load file conversions to a separate system when 
you are converting a file from one format to another (such as from MPEG to 
QuickTime®).
23



 Chapter 1 MediaNetwork Hardware Overview
24



Chapter 2
MediaNetwork Workgroup 
Overview

This chapter provides an overview of a MediaNetwork workgroup, including:

• MediaNetwork Architecture

• MediaNetwork Data Flow
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MediaNetwork Architecture

The components of a MediaNetwork workgroup (see “MediaNetwork 
Architecture”) enable multiple MediaNetwork clients to:

• Connect to a set of shared drives (collectively called the MediaNetwork 
drive set).

• Digitize or record, play, and edit video and audio media.

Several editing clients can access the data stored on the MediaNetwork drive 
set simultaneously.

MediaNetwork Architecture

MediaNetwork Storage Subsystem

The MediaNetwork storage subsystem is responsible for storing, retrieving, 
and managing all data and consists of the following components:

• MEDIASwitch 16-4G and Fibre Channel network

• File Manager and optional backup File Manager

• MediaNetwork drive set

MediaNetwork Drive Set
(Fibre Channel drives)

File 
Manager

.

.

.
Up to 24 Fibre Channel clients

MediaNetwork Storage Subsystem

Backup File 
Manager

(optional)

M
E

D
IA

S
w

itc
h 

Client

Client

Client

Client

Fibre Channel network 

Rack-mounted components
26



MediaNetwork Architecture
MEDIASwitch 16-4G and Fibre Channel Network

The Fibre Channel network is a high-bandwidth network that supports the 
high throughput required for multiple MediaNetwork editing clients to share 
video and audio files.

The MEDIASwitch 16-4G is the backbone for the Fibre Channel network. It 
directs communications among the MediaNetwork clients, File Manager, and 
MediaNetwork drive set.

File Manager and Backup File Manager

The File Manager or backup File Manager controls all data access to the 
MediaNetwork drive set. It handles requests from MediaNetwork editing 
clients by directing them to the appropriate file locations on the drive set. After 
the File Manager provides a MediaNetwork editing client with a file location, 
the actual data transfer occurs directly between the client and the storage.

MediaNetwork Drive Set

The MediaNetwork drive set consists of MEDIArray ZX drives enclosed in 
one or more rack-mount MEDIArray ZX drive enclosures. You connect drive 
enclosures to the MEDIASwitch 16-4G individually or you loop them in pairs 
to reduce the number of connections they require to the switch.

The File Manager handles the MediaNetwork drive set as a single virtual unit, 
which simplifies storage management. For details on the physical and logical 
organization of the MediaNetwork drive set, see “MediaNetwork Storage 
Overview” on page 32.

MediaNetwork Clients

To access data on the drive set, a MediaNetwork client passes a file request to 
the File Manager. The File Manager returns the requested file’s location 
information to the client, enabling the client to access the data directly from 
the drive set. This process avoids a bottleneck at the File Manager while it 
handles the file transfer, freeing the File Manager to handle file requests from 
other clients.
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MediaNetwork from the User’s Perspective

MediaNetwork clients mount workspaces in one of several ways:

• By mapping drives or using the Connection Manager on Windows Fibre 
Channel clients

• Using the Chooser on Macintosh Fibre Channel clients

• Using the Connection Manager on Windows or Macintosh Ethernet 
clients

Several MediaNetwork clients can mount the same workspace concurrently. 
This allows the clients to access the same media and to start using it after the 
media is written to a workspace.

MediaNetwork Data Flow

“MediaNetwork Client Request Data Flow” traces the data flow from a 
MediaNetwork editing client request to data retrieval. The following 
procedure explains the numbered steps in the illustration.
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MediaNetwork Data Flow
The typical MediaNetwork editing client data flow consists of the following 
steps:

1. The MediaNetwork client issues a request to the File Manager through the 
MEDIASwitch 16-4G.

2. The File Manager locates the requested file in its cached copy of the file 
system metadata and sends the file’s location to the MediaNetwork client.

3. Using the location information it received from the File Manager, the 
client retrieves the data from the drive set through the MEDIASwitch 16-
4G.

All requests and responses between the MediaNetwork editing clients and the 
File Manager are handled through a messaging mechanism:

• When a client makes a request, the request is stored as a message on the 
File Manager. The File Manager polls for request messages at regular 
intervals.

• When the File Manager finds a request, it processes a response and stores 
it as a message. 

• MediaNetwork clients poll for response messages and retrieve the 
message information accordingly. Unlike the File Manager, 
MediaNetwork clients poll only when they are expecting responses. The 
entire process for data retrieval to begin takes less than 1 second.
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Chapter 3
MediaNetwork Management 
Overview

Understanding your MediaNetwork storage and how it is configured is part of 
your management tasks. Several tools help you set up and manage your 
MediaNetwork workgroup. This chapter provides an overview of the storage, 
the tools, and the tasks you perform with them.

This chapter provides an overview of administering your environment, 
including:

• MediaNetwork Storage Overview

• Management Tasks

• Management Tools
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MediaNetwork Storage Overview

MediaNetwork simplifies the management of your storage hardware by 
combining all your physical data drives into a drive set that contains a single, 
large file system.

To use the MediaNetwork file system, you must first assign all data drives in 
the drive set to allocation groups — individually managed file system 
partitions that span multiple physical drives. Allocation groups must contain a 
minimum of four data drives that are the same size. You can have several 
allocation groups to accommodate drives of different sizes, to optimize 
performance, or to improve data security.

Each allocation group is divided into one or more virtual volumes or 
workspaces. These workspaces function similarly to network drives and can 
be mounted by MediaNetwork editing clients (the drive set and the allocation 
groups are transparent to clients). You control access to the workspaces by 
creating user accounts with read access, read/write access, or no access to each 
workspace. 

You can set workspaces to any size at any time, with the following limitations: 

• A workspace cannot be resized to be smaller than 1 GB.

• A workspace cannot be resized to be smaller than the size of the data it 
currently stores.

• The sum of an allocation group’s workspace sizes cannot exceed the size 
of the allocation group itself.

For information on resizing workspaces, see the Avid Unity MediaNetwork 
Management Guide. 

“MediaNetwork Storage Overview” on page 33 shows the relationship among 
drive sets, allocation groups, and workspaces.
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MediaNetwork Storage Overview
MediaNetwork Storage Overview

Protection

You can ensure the data integrity of the MediaNetwork drive set by optionally 
protecting workspaces. When protection is enabled, it creates a duplicate copy 
of each file that is written to the workspace on another drive.

Protected workspaces can provide improved performance because the 
MediaNetwork software uses both copies of a file to provide faster file access. 
They can also be repaired quickly with no data loss if a drive fails. 

n A protected workspace uses twice as much storage space as an unprotected 
workspace. 

Drive Set

Physical (Hardware) Perspective Logical (User’s) Perspective

Workspaces

 

Allocation Group 1

Allocation group 2

(Drives of Size X)

(Drives of Size Y)

(Data drives and 
optional spares)

(Various sizes)

The drive set is partitioned into 
one or more allocation groups. 
These groups are transparent 
to the user, who sees only one 
or more available workspaces.
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Spare Drives

The MediaNetwork drive set can also include optional spare drives that you 
can swap for bad data drives if a drive fails. When you replace a failed drive, it 
appears as a raw drive and must be converted to a spare drive before it can be 
added to the drive set and an allocation group.

Management Tasks

As an administrator, you are responsible for:

• Initial setup and configuration — You must configure the drive set, one 
or more allocation groups, workspaces, and user accounts before a 
MediaNetwork workgroup can be used. 

For more information on initial setup and configuration, see the 
Avid Unity MediaNetwork File Manager Setup Guide. 

• Day-to-day administration — You need to manage your configuration 
to accommodate new users and evolving projects (for example, you will 
have to create, delete, or resize workspaces; create and delete user 
accounts; and change user account access privileges). 

The MediaNetwork software also provides comprehensive monitoring 
tools that allow you to check total storage activity on a regular basis as 
well as that of each connected client. 

For more information on day-to-day management, see the Avid Unity 
MediaNetwork Management Guide. 

• Troubleshooting — When problems occur with the storage hardware, the 
File Manager, or a client, you need to diagnose the problem and, if 
possible, fix it. The MediaNetwork software provides easy-to-understand 
error messages that inform you of problems in your environment as well 
as tools that help you to diagnose and fix problems.

For more information on troubleshooting, see the Avid Unity 
MediaNetwork Troubleshooting Guide.
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Management Tools
Management Tools

The MediaNetwork software provides three tools that run on the File Manager, 
allowing you to set up the hardware and perform day-to-day management 
tasks. The tools are:

• The Setup Manager

• The Administration Tool

• The Monitor Tool

The following sections provide an overview of each tool.

n There are several advanced configuration and troubleshooting tools that you 
should not need to use unless instructed to do so by Avid Customer Support. 
For more information, see the Avid Unity MediaNetwork Management 
Guide.

Setup Manager

You use the Setup Manager to perform storage hardware management tasks, 
including:

• Creating and managing a drive set

• Specifying drives as data drives, spare drives, or raw drives

• Starting and stopping the File Manager service to perform system 
maintenance

• Adding drives to and removing drives from the drive set

• Performing drive maintenance and error recovery operations

“Setup Manager” on page 36 shows the Setup Manager window. The Setup 
Manager runs only from the File Manager. 
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Setup Manager

For more information on the Setup Manager, see the Avid Unity 
MediaNetwork Management Guide or select Help > Setup Manager Help.

Administration Tool

The Administration Tool is the primary tool for the initial setup and day-to-
day administration. It also allows you to monitor storage usage. You use the 
Administration Tool to:

• Create, view, rename, and delete allocation groups.

• Add drives to and remove drives from allocation groups.

• Create, view, rename, resize, protect, and delete workspaces.

• Create, view, edit, and delete user accounts (with optional passwords) and 
assign user access privileges.

• Monitor system usage, including total system bandwidth use, the number 
of active clients, and the bandwidth consumption of each client.

• View a list of informational, warning, and error messages.
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Management Tools
“Administration Tool” shows the Administration Tool. You can open the 
Administration Tool on the File Manager, or on any Windows or Macintosh 
Fibre Channel client (the Administration Tool does not run on Ethernet 
clients). 

Administration Tool

For more information on the Administration Tool, see the Avid Unity 
MediaNetwork Management Guide or select Help > Administration Tool 
Help.

Monitor Tool

The Monitor Tool provides low-level performance-monitoring functions. 
Using the Monitor Tool, you can view:

• The current status of each drive, including its name, number, the amount 
of available storage, the percentage of storage used, and the number of 
current files, if any

• A list of the workspaces that exist on the drive set

• The status of communications between the File Manager and the clients

• Information on the metadata maintained by the File Manager
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• File Manager memory usage

• Log messages

• Counts and service times for client requests

You can also use the Monitor Tool to start and stop the File Manager software 
and to set advanced MediaNetwork features, such as resetting the 
administrator’s password.

“Monitor Tool” shows the Monitor Tool. You can open the Monitor Tool only 
on the File Manager. 

Monitor Tool

For more information on the Monitor Tool, see the Avid Unity MediaNetwork 
Management Guide or select Help > Monitor Tool Help.
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Chapter 4
Other Supported 
MEDIASwitches

Avid no longer ships the original 1-Gb and 2-Gb MEDIAswitches, 7X00 and 
9X00 respectively. An Appendix in the MediaArry ZX4 manual provides 
information on how to configure the MEDIArray ZX4 with those switches if 
you have purchsed a MEDIArray ZX to be connected to an system containing 
those MEDIAswitches. 

You should note the following:

• If you use two different 2-Gb switches on the same system, be aware that 
the two different 2-Gb MEDIASwitchs must be in different allocation 
groups. 

• You must use a 2Gb invironment iwth any DNxHD product.

•



 Chapter 4 Other Supported MEDIASwitches
MEDIASwitches

The older MEDIASwitches can have either 8 ports or 16 ports, and your 
MediaNetwork workgroup can have 1 or 2 switches. The switch allows you to 
connect the File Manager, several PortServer or PortServer Pro systems, 
several MediaNetwork Fibre Channel clients, and up to 7 MEDIArray II (or 6 
MEDIArray ZX(3)) drive enclosures (either individually or in pairs of daisy-
chained enclosures) together.

Each MEDIASwitch isolates its ports, treating each port as an individual Fibre 
Channel Arbitrated Loop (FC-AL). This isolation localizes loop initialization 
events (adding or removing clients, or client restarts) to a particular port. This 
isolation also increases the stability of the Fibre Channel environment. 

All the connections and indicators are on the back of the MEDIASwitch. “An 
8-Port MEDIASwitch” and “A 16-Port MEDIASwitch” show the back panel 
connectors and status indicators for the 8-port and 16-port MEDIASwitches, 
respectively.

An 8-Port MEDIASwitch

A 16-Port MEDIASwitch

Each MEDIASwitch port uses a small form-factor pluggable (SFP) connector 
to attach an optical cable to the MEDIASwitch (see “Small Form-factor 
Pluggable Connector” on page 41). The connectors are removable so that you 
can reconfigure your MEDIASwitch optical cable connections. 
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MEDIASwitches
Small Form-factor Pluggable Connector
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